Nedjelja 8

Modeliranje 3D masinskog
sklopa konacnhim elementima
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Postavka zadatka

Sklop prikazan na slici se sastoji od postolja,
nosaca | osovinice. Elementi sklopa su izradeni
od celika (E=200 GPa, v=0.3). Kontakte
elemenata u sklopu modelirati kao kontakte ko
onemogucavaju razdvajanje, ali omogucavaju
medusobno klizanje bez trenja kontaktnih
povrSina. Odrediti raspodjelu von Mises-ovih
napona sklopa za zadate graniCne uslove |
opterecenje.
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Postavka zadatka

Granicni uslovi: Nepokretni oslonci na donjim povrsinama
postolja

Opterecenje: Sila od 1 kN koja djeluje nadole na gornju
povrsinu nosaca

_Nosac

~ Osovinica

*Donja povrsina cilindricnog dijela postolja je 35 mm
iznad tla

*Visina nosaca je 36 mm od cega je 18 mm u sklopu
sa cilindricnim dijelom postolja

Postolje
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Postavka zadatka

R3.000 -8} : I
R6.000
‘ 60.000
/ R10.000 \ %\\m
&N
Ekstrudirati 5 mm Ekstrudirati 35 mm Ekstrudirati 15 mm
na obije strane na jednu stranu na obije strane
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Postolje
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Modeliranje 3D masinske konstrukcije

Aktivirati program ANSYS i sacuvati

projekat pod nazivom Postolje

1)

I\ save s

- “ 4 | « Desktop » ANSYSPrimjeri zavjezbe > 8 Postolje v O

Organize v New folder
[ Desktop n

ANSYS Primjer

Applied Engine
ArduinosPythc
Autodesk Inver
Bilteni CG
Brake Tester Ce
B5c Thesis

CAE
vl 5

prazan

File name: | Postoljel

Save astype: | Workbench Project Files (*.wbpj)

A Hide Folders

Save

Cancel

=
£ static Structural

B Static Structural (Samcef)

3 Steady-State Thermal

) steady-State Thermal (Samcef)
@) Thermal-Electric

3 Throughflow

@ Transient Structural

21 Transient Structural (Samcef)
@ Transient Thermal

R Transient Thermal (Samcef)

@ Component Systems

B Custom Systems
B Design Exploration d

v R x

T

B | c
Text [

B Bxternal Connection Systems

= Microsoft Office Excel releases.

b The installed Microsoft Office Excel application is not supported. You may meet some issues while using the Microsoft Office Excel system. Look at the Help for the list of supported

T View All / Customize...
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Modeliranje 3D masinske konstrukcije

Kreirati
Structural)

staticku

iInearnu  analizu Static

na shemi projekta (Project Shematic

I\ Resetkasta konstrukcija - Workbench - X
Fie View Tools Units Extensions Help
15 d s Project
&) Import... t [3] Refresh Project  Update Project
v X

|2 Analysis systems

4 Design Assessment
@) Electric

¥ Bolict Dynamics

(& Fluid Flow - BlowMolding (Polyfiow)
& Fluid Flow- Bxrusion(Polyflow)
& Fluid Flow (CFX)

(@ Fluid Flow (Fluent)

& Fluid Flow (Polyflow)

¥ HarmonicResponse

E¥ Hydrodynamic Diffradion

& Hydrodynamic Time Response

&4 1CEngine

£ LinearBuckiing

# Linear Buckling (Samcef)
() Magnetostatic

@8 Modal

i Modal (samcef)
ffl Random vibration
fil) Response Spectum
£ RigidDynamics
£ Static Structural
E& Static Structural (Samcef)

) Steady-State Thermal

[ steady-State Thermal (Samcef)
@) Thermal-Electric

@ Throughfion

£ Transient Structural

[ Transient Structural (Samcef)
R Transient Thermal

R Transient Thermal (Samcef)
[EI Component Systems

@ Autodyn

i BladeGen

@ o

& Enaineerina Data

bl A
2 @& EngineeringData v
3 @ Geometry
4| @ Model
5
6
7

@ setp
§3 Solution
@ Results

Static Structural

v

[

View Al f Customize. ..

& Ready

9 Show 1 Messages

1211 PM
=

4/24/2020
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Modeliranj

e 3D masinske konstrukcije

Aktiviratt mo

dul Design Modeler (Geometry-

>New Geometry)

v A
il 7 Static Structural
@ A: Static Structural - DesignModeler L X
2 9 EngineeringData " | File Creste Concept Tools Units View Help
1 |2 & & || Dinde GFRedo \Se'm\‘hh'\@@@.h'\ll\l Q@QIQQ{%EEIH*Q\.Ma\lvllv,{v/vAvﬁ',{vﬂP’
3 I. Geomelry @ - | xtane = |l o - 8 || ) Generate W s / EParameters \Eamde BRRevolve @ Sweep @ Skin/Loft || @ Point 2 Corversion || WMThin/Surace @ Elend » & Ch » i
4 @ Modd il =l = -
2 Import Geometr 3 XYPlane
L a Setup Y ¢i. ZXPlane
| == b YZPlane
6 % Solution 23 Duplicate /& 0Parts, 0 Bodies
7 @ Rests Transfer Data From New
Static Struct Transfer Data To New
# Update
%] Refresh
Remt Sketching  Modeling
Details View 2
25| Rename
Properties
Quick Help
¥
Add Note
@
X
0.000 10.600 2,000 )
5.000 i 15.000
Model View | Print Preview
| @ Ready [No Selection [Meter Degree 0 o 4
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Modeliranje 3D masinske konstrukcije

Podesiti duzinske jedinice (Units->Milimeter)

@) A: Static Structural - DesignModeler

| File Create Concept Tools | Units View Help

| AHBE @ || DUndf  Meter RERR v Es S+ QARQAQQEHE G 2]l W £ 4+ L A f- A7
\ XVPlane > 3| Nond C""""Ete‘ are To [EF]Parameters || @ Point &) Conversion
| Betude farevoe d * LA . . fer MmSiice
'T Outline Micrometer
ee
= Foot
=& A: Static Structural ’Dh
5k XVPlane =
Loy b ZXPlane Large Model Support >
= YZPlane —
/&8 0Parts, 0 Bodies ¥ Degiee
Radian
Model Tolerance

Sketching  Modeling

Details View 2

Y
0.00 3500 70.00 (mm) ZA ;
I 20O
17.50 5250
Model View | Print Preview
a |No Selection
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Modeliranje 3D masinske konstrukcije

UCitavanje eksterno generisane geometrije (File-
>Import External Geometry File) *.sat format

- X

e

FINEEILCOL L RE
olgz|z|zs|3HE|gss ¢ @

Cri of Tools Units Vi Help
Refresh Input T RRER - EE||SECQAQARQAQA T |k Ge (12| B W~ A~ A S A A A~
art eral Top: ameters || gpPoint ) -
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Modeliranje 3D masinske konstrukcije

UcCitavanje eksterno generisane geometrije
okoncati komandom Generate

@ A: Static Structural - DesignModeler s X
| File Create Concept Tools Units View Help
| OB @] Dude Credo |[seect[*y b MB@RB (&0 |8 || SE-QAQAQTAQRAL | h@le (/0] W- W~ 4~ A~ 4 A~ f- A &

| xvPiane v 3| None ~ ¥ || o Generate @@ Share Topology [E|Parameters || @ Point B Conversion

| BEtrude gaRevoive @pSweep § Skin/Loft || @Thin/Surface Q@ Blend v Q Chamfer @ Siice
Graphics

3 XVPlane
o ZXPlane
o YZPlane
oy 8 Importl
£, 3 Parts, 3 Bodies
. @ Osovinica
. @ Nosaé
(@ Postolje

Sketching Modeling

Details View
i~ Details
Subject |
Author |
Prepared For |
= Units
Length Unit Millimeter
Angle Unit Degree
Large Model Support | OFf
Maodel Tolerance Normal
First Saved | Tuesday, June 2, 2020
Last Saved | Tuesday, June 2, 2020 |
Product Version |15.0 Release
Saved Feature Data | Partial
-/ Graphics
Facet Quality [s
[ @ Ready [Millimeter Degree o b,
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Modeliranje 3D masinske konstrukcije

Aktivirati modul Static Structural (Model->Edit

4

A

8l 7 Static Structural

2 | @ EnginesringData v

3 () Geometry

V'

4| @ Mocel

5 e Setup

6 & Solution
7 @ Results
Static Strug

@ e

=3

Duplicate

Transfer Data From New
Transfer Data To New
Update

Clear Generated Data
Refresh

Reset

Rename

Properties

Quick Help

Add Mote

@ A : Static Structural - Mechanical [ANSYS Muitiphysics]
| File Edit View Units Tools Help || @ =% | fSolve v 2/ShowEmors Hl Wt [ & [A] (@~ @ worshee i
[2AYRER--EARE & SPaQQ@AQAFE 2 E S| O
| WM EdgeColoring v £~ A~ A~ A~ A~ A |l |+ Thicken Annotstions
| Model | @ Construction Geometry | @i Virtual Topology | @i Symmetry | @, Remote Point | i
Filte: Name v
/@ Project
B 111odel (as)]

=)

Geometry

| F Show Vertices  g@Wireframe | 1,1

@ Fracture | @ Mesh Numbering | (@) Solution Combination | #QNamed Selection

-~ @ Osovinica
@ Nosaé
v @ Postolje
v Coordinate Systems
/) Connections
-/ Mesh

-9/l Solution (A6)
(3] Solution Information

Details of "Model" b
= Filter Options

Control |Enabled

=1/ Lighting

Studijski program MaSinstvo — Konstruisanje pomoc¢u racunara

Ambient [0.1
Diffuse 0.6
Specular |1
Color

Association Timestamp
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Modeliranje 3D masinske konstrukcije

Podesiti sve automatski detektovane kontakte
Details of Contact Region->Definition->Type->No
Separation

@ A : Static Structural - Mechanical [ANSYS Muitiphysics] — X
| File Edit View Units Tools Help || @ =% | #Solve ~ ?/ShowErors tll mf [ & [A] (@~ B von in
2PAHAYR-VC-ERBER &SP AQ QaBFAAE T E O | B Show Vertices  #RWireframe | i <1, . % M Random Colors {75 Annotation Preferences
| M EdgeColoring v £~ fiv A~ A~ A~ A Pl |-l Thicken Annotations
| Connections (@l Connection Group M, Contact v B, Spot Weld i /1= Coprection Rele: “8ody Intersction | @xBody-Ground v ,Body-Body v [ Body Views (@ Sync Views | B
Outline 7
Filte: Name v 2
@) Project
& (8 Model (A4)
-4 Geometry
-~ @ Osovinica
@ Drial
@ Postolie

v Coordinate Systems
=t Jﬂa Connections
=@ Contacts
/. ContactRegion
. ContactRegion 2
-+ ¥, Contact Region 3
/B Mesh
=-9[2] Static Structural (A5)
7 Analysis Settings
=] 7[g Solution (A6)
3] solution Information

Details of “C jion 2*

= S(ope "~
|Scoping Method [ Geometry Selection
Contact | 1 Face
Target 2 Faces
Contact Bodies
|Target Bodies

= Definition

Scope Mode
' Behavior
[Tim Contact
| Trim Tolerance
Suppressed
S e—

Section Planes 2 x Messages
EEETS

v £Print Preview)\Report Preview]. - ]

Tet Association Timestamp

[0/ No Messages No Selection Metric (m, kg, Degrees rad/s Cel
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Modeliranje 3D masinske konstrukcije

Definisati veliCinu konacnih elemenata Mesh-
>Insert->Sizing

@ A Static Structural - Mechanical [ANSYS Multiphysics]

| File Edit View Units Tools Help || @ =% | fSolve v 2/ShowEmors Hl Wt (4] 4 [A] (@ v (J7Worksheet ix

[ RAYR-VERRER &SP AQAQQEQAQRE TS E DO | F Show Vertices @@ Wireframe | ™7 Shiow e
| M EdgeColoring v £~ fiv A~ A~ A~ A |P| |-l Thicken Annotations

|Mesh =/ Update | @ Mesh v @, Mesh Control w | | Ivietric i

- X

M Random Colors > Annotation Preferences

Filter: Name - B g
@] Project
= @] Model (A4)
B A Geometry
.+ ® Osovinica
» @ Drzad
v @ Postolie

v Coordinate Systems
£, Connections
El-,@ Contacts
- W, No Separation - Osovinica To Drial
4. No Separation - Osovinica To Postolje

i, No Separation - Driat To Postolje
R R — e

5745 paun s |

¥, Contact Sizing

+ Generate Mesh

il of °f Preview >
Deteiisial Thtesh S , BB Mepped Face Meshing
1| Defaults % ) @ Match Control
[Physics Prefer{ 5/ Create Pinch Controls i
e @ Pinch
|| PSRN Y Clear Genersted Data A Inflation
i alb Rename (F2) =
[=I| Patch Conform  Sgart Recording l ¢
Triangle SurfaceTwesmer 7 Y X
=/ Patch Independent Options
Topology Checking Yes
[+ Advanced o
Geometry A Print Preview\ Report Preview/ |
Section Planes 7 x Messages 2 x
| TR Timestamp
]
|0 No Messages No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius

S 1) &
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Modeliranje 3D masinske konstrukcije

U polje Details of Sizing->Element Size unijeti
0.025 m. lzabrati sva tri tijela i aktivirati Details of

Sizing->Geometry->Apply

@D A : Static Structural - Mechanical [ANSYS Multiphysics] - X
File Edit View Units Tools Help % | fSove v ?/ShowErors Hl WY (] 4 [A] @ [FPWorksheet ix
i S ol ol H S S QQ QA= O 5 Show Vertices @@ Wireframe | “'2 </ 1 X M Random Colors 05 Annotation Preferences

W EdgeColoring v £+ Aiv A+ 2 4w A Pl |- Thicken Annotations

|Mesh =/ Update | @ Mesh v @ Mesh Control v | (|11

Outline L]
Filter: Name - B 4=
@) Project ~
B [§] Model (A4)
B, 8 Geometry
-+ ® Osovirica
@ Driaé
-, @ Postolie

[,k Coordinate Systems
£, Connections
Bl /@ Contacts
B, No Separation - Osovinica To Driat
¥, No Separation - Osovinica To Postolje
B, No Separation - DriaZ To Pestolje
-8 Mesh
2@, sizing
E--9[=] Static Structural (A5)
7 Analysis Settings
Bl Solution (A6)
(3] Solution Information v

= Scope
Scoping Method | Geometry Selection
Apply [ Cancel
| Definition
Suppresseg

¥ Element Size
Element Size | 2.5¢-002m

I\ Geometry {Print Preview ) Report Preview/. |

R x Messages

Association Timestamp

Metric (m, kg, A) Degrees redfs Celsius

4 1) @ SR
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Modeliranje 3D masinske konstrukcije

Generisati mrezu konacnih elemenata Mesh-
>Generate Mesh

GD A Static Structural - Mechanical [ANSYS Multiphysics]
| File Edit View Units Tools Help || @ =% | “/Sove ~ ?/ShowEmors tll 6 (& & [A] (@~ (FPWorksheet in
A YR--AERRER S-S PARAAQEAQAE 2 E |0 | B Show Vertices  #RWireframe | i <1, . % M Random Colors {75 Annotation Preferences
| WM EdgeColoring v £~ fiv A~ A~ A~ A Pl |- Thicken Annotations

|Mesh -J Update | @ Mesh v @, Mesh Control w | |jiet

- X

Filter: Name - B =
&) Project "
& @] Model (A4)
- Geometry
x @ Osovinica
« @ Drial
« 8 Postolie

A Coordinate Systems
£,/ Connections
Bl {@ Contacts
B, No Separation - Osovinica To Dria¢
/. No Separation - Osovinica To Postolje
¥, No Separation - Driat To Postolje

R
A Generate Mesh
v
Preview e 2
Show »
=} Create Pinch Controls

[Physics Preferenc
_ Relevance | 1 Clear Generated Data
il Sng 4b Rename (F2)

| Patch Conformini  Start Recording
Triangle Surface M&sHer TPragram Contralled
1| Patch Independent Options
|Topology Checking Yes
| Advanced
% Defeaturing
| Statistics

Geometry {Print Preview) Report Preview/. ]

Section Planes 8 x Messages
] T E ) Ted Associ imestamp

0/ No Messages No Selection Metric (m, kg, N, 5, V, A) Degrees rad/s Cel
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Modeliranje 3D masinske konstrukcije

Dodati nepokretni oslonac na donje povrsine
nozica postolja Static Structural->Insert->Fixed
Support

G A: Static Structural - Mechanical [ANSYS Multiphysics] — X
File Edit View Units Tools Help || @ =% | </Solve v ?/ShowErmors Tl W& [0 4 [A] @~ Byvor i
| = mr R DRBR /& SHaQaeaqa@aqaXnags o0 P Show Vertices  gRWireframe | T Show Mesh & Il Random Colors @ Annotation Preferences

Wl EdgeColoring v £~ A~ A~ A~ fiv A Pl =l Thicken Annotations
| Environment @k Inertial v @k Loads v @k Supports v @ Conditions v @ DirectFE v | B

Filter:  Name - B ==
=) Project
= g Model (Ad)
B, 8 Geometry
« @ Osovinica
« @ Driaé
-y @ Postoie
[,k Coordinate Systems
/@ Connections

B8 Mesh @, Pressure
B, Body Sizing

e wﬂm Z.. Hydrostatic Pressure
ol I .

Acceleration
Standard Earth Gravity
&, Rotational Velocity

v
> % som . Remote Force
SRR Y Sg‘h it @, Bearing Load
#1 ] Clear Generated Data "] Bolt Pretension
b Rename (F2) ), Moment
s R
3 Open Solver Files Directory = Line el
Details of “Static a5y ®j Thermal Condition
= | Definition @ Joint Load
Physics ype Structural S, Fluid Solid Interface

Analysis Type Static Structural @ Ao
Solver Target Mechanical APDL =

@, Displacement

- Options @ . 7
Environment Temperature | 22. °C % Remote Displacement
Generate Input Only No @, Frictionless Support
@, Compression Only Support
@, Cylindrical Support .
), Elastic Support 0.000 0.035 00706
I T ¥

@, Constraint Equation 0018 0053
&), Nodal Orientation {Report Preview/ ]
@

Section Planes =2 Hocllorce B Tabular Data L

B, Nodal Pressure

@ Nodal Displacement
@, EM Transducer

o Motion Loads. .0 No Messages No Selection Metric (m, kg, N, 5, V,A) Degrees rad/s Celsius
P

345PM
Il

[E: Commands ] s =g )@ SR 0
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Modeliranje 3D masinske konstrukcije

Dodati silu na gornju povrSinu drzaCa Static
Structural->Insert->Force

@ A Static Structural - Mechanical [ANSYS Multiphysics] — X
| File Edit View Units Tools Help | @@ =% | :#Solve ~ 2/ShowErors Hl Wb (& & [A] @~ v in
PAYR--EARARE &SP aAQ qEAAR I E SO | & Show Vertices @@Wireframe | Ty Show Mesh & I Random Colors 5 Annotation Preferences

|,',' Edge Coloring ~ ,{g A' A,' A- A' A H \iThichnAnnmmons

| Environment @ Inertial » @ Loads v @ Supports v @ Conditions v @ Direct FE

B

Filter: Name - B ==
&) Project
= (8] Model (A4)

- Geometry

x @ Osovinica -
« @ Driad @ Acceleration
x @ Postolje Standard Earth Gravity

B, 2K Coordinate Systems

-8 Connections

-, & Mesh B, Pressure
B, Body Sizing

&, Hydrostatic Pressure
& ﬁm.mmm i
groee |

@, Rotational Velocity

@, Remote Force
@, Bearing Load

B » :
3| ] Clear Genersted Data " Bolt Pretension
b Rename (F2) @, Moment
e &, Line Pressure
TR ‘ 3 Open Solver Files Directory B e o
= Definition @ Joint Load
Physics Type [Structural @ Fluid Solid Interface
Analysis Type | Static S!Vluttu ral s’ Foned Suppont
Solver Target | Mechanical APDL Z
— @, Displacement
=1 Options Q’ Pl
Environment Temperature | 22. °C o, *k.’“.‘m Displacement ‘e
Generate Input Only [No @, Frictionless Support

@, Compression Only Support
& Cylindrical Support

@, Elastic Support 0000 0.035 o‘almqm)

- I I

@), Constraint Equation 0018 0.053

@, Nodal Orientation e TaaeR]. ]

@, Nodal Force

@, Nodal Pressure
@, Nodal Di
@, EM Transducer

& Tabular Data

£

1.0 No Messages No Selection ~Metric (m, kg, N,5, V, A) Degrees rad/s _Celsius

£ - g 1) @ SRP ]

&R Motion Loads...

[E: Commands 6/3/2020
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Modeliranje 3D masinske konstrukcije

Zadati intezitet sile Details of Force->Definition-

>Define  By->Components
Components unijeti -1000 N

GD A static Structural - Mechanical [ANSYS Multiphysics]
File Edit View Units Tools Help || @ = | J#Sove v ?/ShowEmors tl 6 [0 4 [A] @~ Brvor i
RANE- -HNEE @ S5TAQ QAR e s o0
Wl Edge Coloring v £~ A~ A~ A~ A~ A Pl |-l Thicken Annotations

| Environment @k Inertial » @ Loads v @ Supports v @ Conditions v @ DirectFE v | Bt

Outline 4
Filter: Name - Bam
@] Project
= (@] Model (A4)

= M8 Geometry
« @ Osovinica
« @ Driat
« @ Postolie

v Coordinate Systems

/B Connections

/& Mesh
- 8L, Body Sizing

=-/2] static Structural (A5)

/7 Analysis Settings
/B, Fixed Support
/@‘ Force
Bl /@) Solution (A6)
(3] Solution Information

RO

|- Scope
Scoping Method | Geometry Selection
Geometry 1 Face

-/ Definition

g Force

Pefine By Components

|Coordinate System | Global Coordinate System

X Component |0.N (ramped)

¥ Component | 0.N (ramped)

-1000. N (ramped)

No

u pole

- X

' Show Vertices @R Wireframe | TShow Mesh & Il Random Colors @ Annotation Preferences

0.070(m)

Geometry A Print Preview ) Report Preview/

Section Planes 3 x Graph

# Tabular Data

‘t]i?@ [—'___
[

] Messages. Graph

|0 No Messages No Selection
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Modeliranje 3D masinske konstrukcije

|zabrati analizu koja se zeli realizovati Solution-
>Insert->Total Deformation / Equivalent Stress

@@ A : static Structural - Mechanical [ANSYS Multiphysics] — X
| File Edit View Units Tools Help || @ =% | <fSolve v ?2/ShowErmors Tl 6 [@ # [A] @~ Mo in
AYERE-A-ARER &S QR | QaRxmnmeg e |0~ | 7 Show Vertices @B Wireframe | T ShowMesh & Il Random Colors & Annotation Preferences

Bl Edge Coloring v £~ Jiv A~ A~ A~ A |Fl |-lThicken Annotations

| Solution ®, Deformation v @, Strain v @, Stress v @ Energy v | @ Damage v | % Linearized Stress v | @ Probe v (@] Tools v | @, User Defined Result vipbell Dizg | @, Coordinate Systems v B
Filter  Name - B adems
B @] Model (Ad) A
=, 8 Geometry
x @ Osovinica
x @ Driad
x @ Postolie

2% Coordinate Systems
(- Connections
-8 Mesh
/B Body Sizing
=[] Static Structural (A5)
Lo 7N Analysis Settings
/9, Fixed Support
B, Fore
-4/

/(3] Solution Information
/9 Total Deformation

o BT

Details of “Equivalent Stress* 2
=1 Scope ~

Scoping Method Geometry Selection

Geometry | All Bodies
=/ Definition

Tpe Equivalent (von-Mises) Stress

By Time

Display Time Last

| Calculate Time History | Yes

Identifier

Suppressed No 0.000 0.035 \ 0.070(m)
= Integration Point Results I — ]

Display Option Averaged 0018 0.053
| coaeAcTos Bothes [No v \Geometry {Print Preview ) Report Preview/. ]
=l pecuits 1
Section Planes 2 x Graph # Tabular Data
FEEX \
I ] - Messages Graph

.0 No Messages No Selection Metric (m, kg, N, 5,V, A) Degrees rad/s Celsius
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Modeliranje 3D masinske konstrukcije

Aktivirati izvrSenje analize Solution->Solve

@ A Static Structural - Mechanical [ANSYS Muitiphysics] - X
| File Edit View Units Tools Help || @ *+ | </Solve = ?/ShowEmors Tl ¢ [8 & [A) [@)~ @ voionec iy
(BN R R @‘@ B - ISL+a egaarnegas s O | 5 Show Vertices g8 Wireframe | T Show Mesh & [l Random Colors ) Annotation Preferences
| MEdgeColoring v £~ A~ A~ A~ A~ A Ml |-l Thicken Annotations
| Solution @, Deformation + @ Strain v @; Stress v @, Energy v | @, Damage v | @ Linearized Stress v | ‘@ Probe + [ Tools v | R, User Defined Result | £/ wararn | @y Coordinate Systems v [&
| Outline
| Filter:  Name - B & m
= [ Model (A4) ~
=/ Geometry
x @ Osovinica
|-« @ Dria
x @ Postolje
% Coordinate Systems
/) Connections
28 wesh
/@, Body Sizing
/(2] Static Structural (A5)
- 7N Analysis Settings

1+ /B, Fixed Support
- B, Force

B "'@?‘ e Insert >
= ; P 5o

0-2-&

] Clear Generated Data ¥
Details of "Solution (46)" | db Rename (F2)
=1 Adaptive Mesh Refinem¢
i Max Refil Loops |
|Refinement Depth |2,

E

_1 Open Solver Files Directory

[status [Solve Required

0.070(m)

\ Geometry A Print Preview ) Report Preview/ ]

Section Planes a x Graph

| | Messages Graph

\ \ LQ No Messages No Selection Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4
~ ) &
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Modeliranje 3D masinske konstrukcije

Polje pomjeranja sklopa

() A: Static Structural - Mechanical [ANSYS Multiphysics]

| File Edit View Units Tools Help || @ =i | </Solve ~ 2/ShowErors Hll [f [0 # [A) @~ B vorhest iy
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Modeliranje 3D masinske konstrukcije

Polje ekvivalentnih napona sklopa
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Da bi se pregledalo pomjeranje za pojedinacni
element Solution->Insert->Total Deformation /
Equivalent Stress potom izabrati, npr. osovinicu

G A static Structural - Mechanical [ANSYS Multiphysics] = X

File Edit View Units Tools Help || @ =% | “#Sove v ?/ShowEmors tl 6 [ 4 [A] @~ By von in
2 4 R R ARER &S ¢ 6 Q|8 QoxnadeE | 0O  Show Vertices @@ Wireframe | T Show Mesh & Il Random Colors @ Annotation Preferences

Wl Edge Coloring v £~ A~ A~ A~ A~ A Pl |-l Thicken Annotations
| Solution %, Deformation v @ Strain v @, Stress v @ Energy v | @ Damage v | @, Linearized Stress v | @ Probe v @] Tools v | @, User Defined Result
Outline L
Filter: Name v
=& Geometry A
-y @ Osovinica
« @ Driad
« @ Postolie
[y Coordinate Systems
/8 Connections
=& Mesh
/. Body Sizing
=-/[2] Static Structural (A5)
w7 Analysis Settings
A8, Fixed Support
" FoLgs
olution (A6)
/41 solution Informaton
/8 Total Deformation
B Equivalent Stress.
/8 Total Deformation 2

| ®, Coordinate Systems v [

= Scope -

Scoping Method
Geometry
= Definition

By
Display Time

Identifier
Suppressed
= Results.
Minimum
Maximum

‘Section Planes

Geometry Selection
Apply

I

Cancel

Total Deformation
Time
Last

Calculate Time History | Yes

No

[ Minimum Aers on |

v

I
0.015 0.045

Geometry A Print Preview )\ Report Preview/

3 x Messages

EEEX
[

# X Tabular Data

==
|«
Messages | Graph

Studijski program Masinstvo — Konstruisanje pomocu racunara

>

Metric (m, /) Degrees rad/s Celsi
400 PM
0




Modeliranje 3D masinske konstrukcije

Polje pomjeranja osovinice

@ A Static Structural - Mechanical [ANSYS Muitiphysics] - X

| File Edit View Units Tools Help || @ <=} | =fSove = ?/ShowErrors 1l W (8] & [A) (@~ @ workshest i
| ® 'Y R B[ D@ Israaea@aesEnesga ol M- | 7 Show Vertices R Wireframe | “how Mesh & I Random Colors  $ Annotation Preferences
| WMEdgeColoring v £~ A~ A~ A~ A~ A |l I-IThicken Annotations
|Result  1.e-003 (Auto Scale) + @~ B~ @i~ 3 | W 0w | EHProbe | Display Al Bodies -
Outline .
| Filter  Name - B aid=
i x @ Osovinica A
@ Driaf
x @ Postolje

2 Coordiate Systems
/B Connections
&8 Mesh
L. A, Body Sizing
/=] Static Structural (A5)
L 7N Analysis Settings
/3, Fied Support

o B, Force
£/ Solution (A6) -
- /3] Solution Information A5613e-6
A Total Deformation 4.3069e-6
- /B Equivalent Stress 4,03250-6
A Total Deformation 2 3.7581e-6 Min
/& Equivalent Stress 2
v
Details of "Total Deformation 2" 2
=/ Scope B ~
Scoping Method | Geometry Selection .
[Geomety |1 Body ] I
= Definition A .
Type Total Deformation
= Display Ti T':: -
isplay Time a. g 5
Yes
Suppressed No 0.000 0.030 0.060 (m)
= Resuts I 0O
_ Minimum |3.7581e-006 m oo 002
Maximum | 6:2275e-006 m = = =
e v |\Geometry {Print Preview ) Report Preview/ ]
Section Planes 7 x Messages X
fo —
I MmiaEx» i < >
| | Messages | Graph

| 3 Messages No Selection Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius A

Studijski program MaSinstvo — Konstruisanje pomoc¢u racunara




Modeliranje 3D masinske konstrukcije

Polje ekvivalentnih napona osovinice
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